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Anytime you enter the learning curve you are focusing on your weaknesses – this is just part of any 
learning curve – I realize this is frustrating for everybody, but it is the way it is. 

 
In class you will get lost, get behind, get frustrated … repeatedly 

 
Take a deep breath 

Stretch 
And I will be covering something else in 10 minutes, so hang on…. 
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Forward: Basic and Intermediate Class 
Brain Noise Intro: 

 
 
Welcome to David’s brain.  
 
I have been working with ADT in architectural design and production, in beta testing, as a courseware 
writer, and instructor since early in 1998. I often feel in classes that I have too much information to give 
you. Often times when I give a class, I spew some piece of information, and a student will ask… “Is this 
written down somewhere?”. Well most of the time the answer is Yes, but too often the answer is yes, but 
you might spend an hour or so trying to track it down… As such, this document was created as much to 
give you space to take notes as it is to force me to organize the concepts I want to convey in the basic 
and intermediate class. 
 
You will see Brain Dumps occasionally fall out of the ADT newsgroup. A Brain Dump is usually a group of 
thoughts prepared by one of the programmers explaining why they created something in one way or 
another. This document is almost but not quite entirely unlike a brain dump. I have been using the term 
Brain Noise for a long time. To me, this is my brain noise – very informal, definitely always a work in 
progress. This is not a complete documentation as much as the general ideas, concepts and oddities 
about the objects that I would like you to take away from the basic and intermediate classes.  
Concepts such as “What is stored in the properties Vs the style of an object”.  
Oddities such as “Why did they issue ADT 2007 in April of 2006?”... 
 
 
 
 
 
As is noted in the syllabus, I want you to take 3 main ideas away from this class, and everything in the 
class will elaborate in one way or another on the following concepts 
 
Architectural Desktop objects are different from AutoCAD lines arcs and circles in three ways: 
 

• Objects have display representations – or a set of instructions to the graphics card saying “show me 
this way” 

• Objects are style based. Styles generally contain the variables that affect how the object is 
constructed in the real world. Styles can also contain overrides to the display representations. 

• Objects have relationships to other objects. Generally these relationships are Anchors, but there 
are others: How walls clean up, how schedule data populates the table from the objects, on and on… 

 
Two secondary ideas that I want to convey in the basic class are: 

• Use the right mouse button 
• Watch the command line 
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Have I said yet, 
 
 
 
 

Use the right mouse button 
 

or 
 

Watch the command line 
 
 

? 
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Odds At the End 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Truly a place to put the really random thoughts about ADT 
Sections here include  

• Getting Drawings to Consultants – the whys and wherefores of exploding your drawings 
• ADT Variables 
• AutoCAD Variables 
• Other Resources 
• Not Really Tips and Tricks 
• Course Evaluation 
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Blowing Up your Project  
There comes a time in every architects life that they will want to blow up their project. While sometimes 
this is after the building is built, this section concerns primarily how to explode the project so that your 
consultants can get just vanilla autocad files the can use, 

Background terms 

ProxyGraphics 
An AEC Object is a set of instructions to the graphics card that says show this (wall, door, roof) to me this 
way.  That set of instructions carries with it the geometry of the object…If I am looking at the object from 
the top, the set of instructions says just show me the plan view or 2D geometry.  If I am looking at the 
object in ISO, show me the model geometry of the object. 
Proxygraphics is a variable that determines if this geometry of the AEC Objects is stored in the drawing.  
Default for install is Proxygraphics = 1.  Saving the geometry (Proxygraphics = 1) increases the file size 
because all the geometry is saved in the drawing. 

 
 
Proxygraphics = 1; Saves the 
proxygraphics (Geometry of the 
objects) in the drawing. 
When opened in “vanilla” ACAD,  
Objects may not be manipulated.  
Layers may be turned on and off, but 
objects will not change color unless 
their object properties are set to be by 
layer.  Objects will appear as the were 
last saved in ADT.  Objects may Not be 
moved, or modified. 
 
 
 

 
 
Proxygraphics = 0; Does not save the geometry 
of the objects in the drawing.  Vanilla ACAD will 
display objects as bounding rectangles with a 
descriptor box telling you this is an AEC object. 
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With Proxygraphics = 1, The Last used view and Display Configuration will rule what is seen by the 
session of vanilla AutoCAD.  In this drawing the last saved view in ADT was a plan view that used the 
screened display configuration.   
 
 
 
 
 
If this model is looked at from another view within vanilla 
ACAD, we can see the Plan Display Set gets used.   The Objects 
are grey and 2D (exceptions are floor slabs, roofs and mass 
groups).  There is no layer control over the sub-objects.  It 
behaves as a nested block. 
 
 
 

While this is the background information, from release 2005 forward vanilla AutoCAD has 
been automatically object enabled. So any of your consultants that are using a release of 
autoCAD after 2005 will not need to load object enabler, and will be able to read the ADT 
objects. This said, note 2 exceptions. 
1) Each release sees a few new objects added to the inventory. Earlier releases will not 
understand these objects (i.e. a 2006 copy of autocad will not understand the new space 
object created in 2007 
2) 2007 changed the drawing format, so even in vanilla autocad a 2006 copy will not 
open a 2007 drawing. 
 

 

Making ACAD dwgs from ADT Dwgs 

04/05/06 = Export to AutoCAD  (formerly Object Explode) (Also in settings for e-
transmit) 
The only thing better than having architectural objects to play with is the ability to explode them without a 
trace so they don’t play havoc in the offices of your consultants who are expecting to plagiarize your 
drawings directly and pocket the money you gave them to draw them from scratch. Export to AutoCAD is 
the ticket. Formerly known as SuperExplode and available only from the beta web site which has a secret 
membership club and changes its URL more often than the suburban housewife changes the tidy-bowl 
container.  This little number has now found its way into the software to the vexation and elation of many 
a CAD manager. 
Located under File > Export to > 2004 format it allows the user to reduce any architectural desktop 
drawing to basic entities that any standard AutoCAD user can use without Object Enabler, or cryptic 
proxygraphics messages. It handles externally referenced files if they exist. 
You don’t have as much in your face control with this 
command as you did in R3, but then again, you just 
might not want too much control…read on… 
The old object explode is still around because many 
people and written script files to make it do whole 
folders of drawings. You can only access this from the 
command line. The command is AECOBJEXPLODE 
if you want to use it, the descriptions are given below 
 
Explode views: 
Current view – This reads the values of the objects in 
the current view only and throws away any display 
information from any other viewport. If the plan view is 
current when command is launched, the result will be 
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2D objects (*generally, roofs don’t, but lets not confuse the issue). If the Model view is current the 
exploded objects will be 3D (to keep consistency of the final product) – The elements will be extruded 
lines and 3D faces, all standard autoCAD entities – ready for rendering by layer…. 
 
All Layouts It does not matter which viewport you are in, the command will give you standard autoCAD 
entities to represent each of the views (viewports) in the drawing.  Do not do this unless you really want a 
bunch of blocks in you drawing 
 
Examples:   
All Layouts - A drawing is set up with two layouts - three viewports; one layout showing the 2D plan in one 
viewport, the reflected plan in another,  a second layout is set up with the model displayed in a single 
viewport.  All views will generate blocks all stacked on top of each other for each of the three viewports in 
the drawing. For each wall you will have:  A 3D block representing the model view, a 2D block 
representing the reflected view, and a 2D block representing the plan view - and they will all be stacked 
on top of each other.  Needless to say (but I will say it anyway), if you have a lot of layouts with multiple 
viewports, you can generate a bunch of extra trash very quickly. 
 
Explode to Anonymous Blocks 
Yes – each AEC Object is exploded to a single block – the block gets assigned the color of the layer 
No, - each aec object is exploded down into acad entites lines etc 
 
Maintain Resolved Layer, Color, Linetype. 
Yes - each AEC Object is exploded to entities, the entities are assigned the layer color and linetype of the 
parent object 
No – each AEC Object is exploded to entities, the entities are assigned layer 0 
 
The rest is pretty self evident? 

2005  notes of file transport to AutoCAD. 
 
1) The above functions are still viable – you can File > Export to > 2004 format. But all of the above also 
applies and I still us AECOBJEXPLODE 
 
2) Consultants using ACAD 2005 need no file translation – 2005 is automatically enabled for ADT. This is 
not true for ABS. 
 
3) There is no DWG file format change from 2004 – 2005 hence there is no export to 2005 format. 
 

2006 notes of file transport to AutoCAD. 
1) The above functions are still available, but they have done substantial work to the export function that 
were not necessarily applied to the AECOBJEXPLODE command. 
 
2) The Export function will produce FLAT 2D drawings even for that group that did not previously export 
flat in 2005 – Structural members, Roofs, Roof and Floor Slabs, mass groups etc. 
 
3)  Export still will export to 2000 or 2004 format dwg. There is no 2006 format. However: 
Things that are new in 2006 like the display theme and the AEC Polygon based break mark will not be 
active in 2005 
Things that were new to 2005 like the field functionality will appear only as text if opened in 2004. 
 

2007 notes of file transport to AutoCAD. 
1) With the release of 2007 and the file format change we are almost stuck with exporting our drawing. 
Basic facts of life say our consultants only upgrade every 4 releases which means that now our 
consultants are working on autoCAD 2004 which will not read our 2007 drawing. Use the export function 
to create the version in a release compatible with the consultants version. 
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Odd Variables 
 
The following is a list of variables and commands I find useful to know, but usually forget on a day-to-day 
basis.  Where a variable is noted as documented, I have cut and pasted the definition from the standard 
help file (respect, credit and thanks given to the writers and Autodesk, Inc. etc). 

ADT Variables  

AECFACETDEV: (now Facetdev (ADT3)):  
Variable from 0 to 1.  Controls tessellation of curved walls 
I.e. 1/8 = more segments than ¾. Set at ½ by default, this value is too larger for my taste.  If you present 
Demo’s, you might want to reset this in your demo sets.  This affects a whole lot of things with curves 
such as the circle of a plan view of a column, and curved profiles set as a shape of a window or custom 
door. – ADT04/05/06 puts this on the Options>AEC Object Setting tab. 

AECVERSION 
Type AECVERSION at the command line to see if the patches have been installed. After the command, 
Hit F2, and scroll to the top of the list.  
 
In ADT 2007, the numbers will read FileVersion: 5, 0, 272, 0 
 
In ADT 2006, the numbers will read FileVersion: 4, 7, 265, 0 
 
In 2005, these numbers should read  4,5,202.0 
 

_VERNUM   
2007 released version = _VERNUM = "A.54.0 (UNICODE)" (read only) 
2006, released version = "Z.54.10" 
Use this command to see if a basic AutoCAD service pack has been installed. Shipping version of ADT3 
= U.1.81, ADT3.3 = K.0.30, ADT3.3+SP1 = K.0.44 (includes 2002 service pack 1) 

DISPLAYDXFNAME - 
Toggle on or off to show the DXF names in the drawing.  You must regenerate the drawing after changing 
toggle.  Useful for finding objects for which you have turned off all display representations (the object 
does not show up in the drawing, but you know it is there).  Also allows you to show and select objects 
that are not shown within the current display system – once the name is displayed you have Right Click 
access to the objects modify and properties. 

HIDEPRECISION - From the ACAD Help file… 
Type: Integer, Not saved, Initial Value: 0 
Controls the accuracy of hides and shades. Hides can be calculated in double precision or single 
precision. Setting HIDEPRECISION to 1 produces more accurate hides by using double precision, but 
this setting also uses more memory and can affect performance, especially when hiding solids. 
0 Single precision; uses less memory 
1 Double precision; uses more memory     
 
Controls accuracy of AEC Hidden line removal (createhlr) and 2D section/elevation.  I set this variable 
before doing a hidden line removal, then reset it back after I am done so as not to affect the standard hide 
command. 

INDEXCTL - Documented 
Values 0,1,2,3 This variable is set in the drawing you want to externally reference into another drawing.  
Setting the indexctl value to 3 in the base drawing will increase speed in the drawing into which it is xref’d 
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as only those layers and entities which are needed from the referenced file will be loaded into the working 
file.  This variable works hand in hand with the DemandLoad variable.   

OBJRELUPDATE –Object relationship update 
If you have changed a schedule and it is not reflecting the changes you made, or if you have xrefed the 
floor plan into a plot sheet and the walls do not clean up, issue this command from the command line.  
For xrefs, sometimes you have to pick the xref to make it work properly otherwise type ALL at the 
command line for the selection set. 
ADT04/05/06 puts an icon at the far right of the standard toolbar called “Regenerate Model” that uses this 
command 
 
From the Readme for ADT3/3.3: (still valid 2004/5) 
If you notice that walls do not clean up properly in Xref files, try disabling demand loading of Xrefs 
(XLOADCTL = 0, also set on Options>Open and Save tab). This will not interfere with the ability to edit 
directly a drawing which is used as an Xref. Demand loading of Xrefs (XLOADCTL = 1 or 2; enabled or 
enabled with copy) is a performance issue in AutoCAD. It only affects the behavior of Xref drawings when 
combined with Spatial or Layer indexing (INDEXCTL). When spatial indexing has been used in the Xref 
drawing (INDEXCTL = 2 or 3), and Xref clip boundaries are active, only the necessary portions of the Xref 
are read into memory. When Layer indexing has been used in the Xref (INDEXCTL = 1 or 3), and layers 
are frozen in the Xref drawing, only the visible layers are loaded. When Demand loading is disabled 
(XLOADCTL = 0), the entire Xref drawing is loaded into memory in spite of any Spatial or Layer indexing. 
There is also a registry setting that can be adjusted to improve wall cleanup when opening a file that 
contains Xrefs. The value is XrefResolveMethod, which is located in the registry at: 
HKEY_LOCAL_MACHINE\SOFTWARE\Autodesk\ObjectDBX\R15.0\AEC\3.0\AecBase\Preferences 
Setting this to 2 will automatically invoke a "super objrelupdate" when a drawing with Xrefs attached is 
loaded. This works with any setting for INDEXCTL. – I have not checked if this is done automatically in 
2004/5. 

SURFU - from the help file: 
Type: Integer, Saved in: Drawing, Initial value: 6, Sets the surface density for PEDIT Smooth in the M 
direction. 
4D Note: This sets the tessellation of a roof.  Note that this must be set at the time the roof is created.  
Existing roofs are not affected by a change in this variable 

Styles: 
Don’t forget \Content\imperial\styles.  More styles such as bar joists and walls as counters and cabinetry. 

Thanks to Bill Glennie also for the following: 
PropertyDataExt: This allows you to see the Style-based and Instance-based property sets on a single 
object.  However, it doesn’t let you see the value of a style-based automatic property that resides on the 
instance.  
AecPurgeLayerStyles is another useful one that is somewhat documented, but is not on any menu. 
“secret” registry settings: For example, under Profiles/…/Preferences/AecBase are settings called 
DwgSetupDoAcadVars, DwgSetupDoLispVars and DwgSetupDoZZblk.  I’m not sure about what they do, 
other than the last one, which will eliminate that nasty AdcaddZZ block that keeps appearing. 
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AutoCAD Variables 

Shortcut switches… 
Right Click>Properties on the desktop shortcut, and look in the target line. The order here is personal, 
those I tweak are first.  By default the install creates a target line that looks like: 
"C:\Program Files\Autodesk Architectural Desktop 3\acad.exe" /t "AEC Arch (Imperial - Intl).dwt" /p 
"C:\Program Files\Autodesk Architectural Desktop 3\adt.arg" 
/nologo – don’t show me the splash screen on startup.  
/t = specifies a template to start with 
ADT uses the following by default /t "AEC Arch (Imperial - Intl).dwt". If you change this, you may have 
display problems with the following objects: Live sections, AEC Dimensions, Areas and Zones.  Because 
these objects were part of the international extension package, the display sets for these objects are not 
set in the AEC Arch (Imperial).dwt 
/p specifies a profile to use.  Note the default /p "C:\Program Files\Autodesk Architectural Desktop 
3\adt.arg" points to an .arg file.  If one of your users REALLY messes up the Architectural Desktop profile, 
delete the profile in the options page, and make sure the target has this line in it.  If ADT does not see an 
Architectural Desktop profile, the .arg will read the values out of the registry and create a new one. 
/c = Sets which hardware config to use (.cfg file), I don’t use this very much, if cfg is corrupt, erase it and it 
should create a new one, or set one here /c c:/Acad will create ACAD2002.cfg in this folder next time it 
starts. Related, is /r “The /r switch restores the default system pointing device. It creates a new 
configuration file (acad2002.cfg) and renames the previous acad2002.cfg file to acad2002.bak.” – from 
help files 
/s = temp path directory ie  d:\acad2002\acad.exe /s c:\mapping;d:\acad2002;e:\autolisp;c:\acad.  Adds 
paths to current support path set in options. Up to 15 paths are allowed, only good for current session – 
use if you set up shortcuts for each job or client.  
/b = run a script on startup.   /v specifies a view to open up to 

Isavepercent - Documented 
Type: Integer Saved in: Registry ADT2, ACAD 2000 -  Initial value: 50 ADT3 initial value 0  
Determines the amount of wasted space tolerated in a drawing file. The value of ISAVEPERCENT is an 
integer between 0 and 100. The default value of 50 means that the estimate of wasted space within the 
file does not exceed 50 percent of the total file size. Wasted space is eliminated by periodic full saves. 
When the estimate exceeds 50 percent, the next save will be a full save. This resets the wasted space 
estimate to 0. If ISAVEPERCENT is set to 0, every save is a full save. 
Undocumented: Default ADT2 install and templates set this variable to 50.  Make sure this is set to 0.  
(default in R3 and 2004/5) End of discussion. ADT3 changes this by default to 0.  Check this setting if you 
upgraded rather than did a full install. 

Wildcards: 
The following wildcards for use in Layer manager and Scheduling:  
Pound Sign # use for any single number 
@ sign – use for any letter 
. (period) – match anything that is not a letter or number 
? – matches any single character 
* matches any string of Characters 
Brackets – []  Match either_or. Example: [Plw]  finds letters P, l or w.  
Hyphen Within Brackets – to specify a range of characters, 
A leading tilde (~) negates the characters; that is, a match occurs if the string does not correspond.  
 
From Scott Reinemann, posted to news group. The pattern string can include multiple patterns, separated 
by commas. Other special characters also have particular meanings; see the table that follows. If a tilde is 
not the first character within brackets, it is treated literally. To specify a literal hyphen as an option within 
brackets, make it the first or last bracketed character (for example, [-ABC] or [ABC-]), or the first character 
to follow a leading tilde (as in, [~-ABC]). To specify a literal right bracket (]) within brackets, make it the 
first bracketed character or the first to follow a leading tilde (as in []ABC] or [~]ABC]). Note: Other special 
characters may be defined in future releases, so use a leading reverse quote (') to escape all special 
characters that aren't used as described in this section. 
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Isolines – from help file  
Type: Integer, Saved in: Drawing Initial value: 4 
Specifies the number of isolines per surface on objects. Valid integer values are from 0 to 2047. 
4D Notes – if you use extrude on a curved pline or circle – although this value is only supposed to control 
the number of tessellated lines in WIREFAME, I think there are some rendering packages that use this 
rather than facetres which is for shaded and hidden line and rendered views 

FACETRES 
Documented…From help file… Type: Real Saved in: Drawing Initial value: 0.5 
Adjusts the smoothness of shaded and rendered objects and objects with hidden lines removed. Valid 
values are from 0.01 to 10.0. 

MaxHatch: Documented environment variable 
From the readme file:  "Long walls with detailed hatch patterns (such as ar-conc and ar-sand) may not 
display the complete hatch by default.  This is due to the MaxHatch setting, which has a default value of 
10000.  To increase this value, use the command (SetEnv "MaxHatch" "1000000").  This will change the 
registry value to allow much more extensive hatch patterns to be displayed properly."  4D Note – you 
have to type the whole thing at the command line and this is case sensitive: 
(SetEnv "MaxHatch" "1000000") 
 

DIMLFAC variable (used to dimension in paperspace) 
 
New for 2005… 

FIELDDISPLAY 0 or 1 
Controls display of fields or not.  
Affects callouts, keynotes anything that uses a field. 

TASKBAR 0 or 1 
Shows multiple open drawing on task bar rather than just one session on task bar 
May cause incompatibility with third party software. 
 

INPUTHISTORYMODE 0,1,2,4,8, 
Controls the content and location of the display of a history of user input.  
The setting is stored as a bitcode using the sum of the following values: 
0 No history of recent input is displayed 

1 History of recent input is displayed at the command line or in a dynamic prompt tooltip with access 
through Up Arrow and Down Arrow keys 

2 History of recent input for the current command is displayed in the shortcut menu 
4 History of recent input for all commands in the current session is displayed in the shortcut menu 
8 Markers for recent input of point locations are displayed in the drawing 

 
 
default is 15, I think is the 8 that is messing us up 
 
I use a setting of 4 so that I can use the up arrow for last command input. This has been a bit sketchy, 
and though I think there is a bug here, I cannot duplicate it consistently enough to find it out. 
 
 
 
 
 
 
 



Odds At The End 

© 2004 David D Driver.                                                     11/8/2007                                                            

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Odds At The End 

© 2004 David D Driver.                                                     11/8/2007                                                            

Odd Resources 
 
This section is just a list of some other resources you can find on the web.  
Beware that Autodesk changes their site fairly frequently, so keeping these links up to date is a bit of a 
guessing game – when in doubt, I try to keep the most current links available in my web site 
www.davidddriver.com 
 

Other Resources 
 
Autodesk is very fond of recreating their web site, so I am giving the picks from the pages in addition to 
the links 

Knowledge Base:  
Query a database of both FAQ type of questions as well as what use to be the “tips and tricks. 

Path: 
www.autodesk.com 
Pick Support 
On the page that pops up, change the Technical support dropdown to Autodesk Architectural Desktop 
that will load: 

Link 
http://usa.autodesk.com/adsk/servlet/ps?siteID=123112&id=2334116&linkID=2476059 
which is on of the front ends to the knowledge base 
Here on this page also are links to  
Support: Self Service support (knowledge base and discussion groups) 
Data and Downloads 

Self Service Support 
This link from the above page gives you access to the knowledge base. 
http://usa.autodesk.com/adsk/servlet/ps/kb?siteID=123112&id=2773303&linkID=2476059 
and the discussion groups GO HERE! 
http://usa.autodesk.com/adsk/servlet/index?siteID=123112&id=2772824&linkID=2476059 
There are a bunch of really bright and helpful people on the discussion group. It is not unusual to have an 
answer to a question posted within an hour. – Product Management, QAQC and other Autodesk 
departments take part, but do very little censoring of this group. 
Basic list of web based discussion groups as well as a search engine for the discussion groups is at 
http://discussion.autodesk.com/ 
If you want to load the newsgroups into a new reader, then link is: 
Generic ADT2005 problem solving news://discussion.autodesk.com/autodesk.aec.arch-desktop2005 
There is a separate newsgroup for plotting issues. 
If you have a problem dwg, post it to news://discussion.autodesk.com/autodesk.autocad.customer-files, 
then tell the general newsgroup the problem and that you posted the dwg file in the customer files.  
General 3DVIZ: news://discussion.autodesk.com/autodesk.viz4.general 
 

Chris Yanchars Blog 
http://autodesk.blogs.com/between_the_walls/ 

Downloads:  
http://usa.autodesk.com/adsk/servlet/ps/dl/index?siteID=123112&id=2334435&linkID=2475897 
Currently Service Pack 1 ADT2005 (came out in October) 
White pages: use the search function to search for white papers, white pages 
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If you want to load the newsgroups into a new reader, then links are: 
Generic ADT4 problem solving news://discussion.autodesk.com/autodesk.aec.arch-desktop2005 
Under the Tools here you will find some conversion tools and any current Object Enabler. 

Other Autodesk sites 

E Learning: http://e-learning.autodesk.com/ 
Modules to pay and download to office self paced learning Sometimes they offer freebies, look up there 
every 
once and a while. 

i-Drop Site: http://idrop.autodesk.com/ 
For those looking to create i-Drop content for their office 

Beta site: http://betaprograms.autodesk.com/ 
Several items of interest including: 
Signing up to be involved in the beta cycle and downloading Beta programs such as any new service 
packs – Do not load beta software on any machine you cannot ghost to get the registry back in order. 
 
http://usa.autodesk.com/adsk/servlet/index?siteID=123112&id=3065989&linkID=2475897 
more styles you can download 

 

Courseware:  
http://partnerproducts.autodesk.com/catalog/category.asp 

CAD Standards 
Here are a few websites on Cad Standards: 
http://paralleledge.com/ 
Click on "downloads" and then "Manual.zip". This was a broken link when last I visited, but there are 
some other useful links to all things CAD 
http://www.calstate.edu/tier3/PPD/AE/CSU_CAD_Stds/CAD_Stds_Inframes.htm 
The CAD standard for the The California State University 
http://www.nationalcadstandard.org/ 
Just like it says 
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Others 
This resources, they are my competition in training, but hey… 
Some are very active on the newsgroups 
Others make Add – Ons for ADT 
http://www.cadmin.com/ - John Janzen – trains, does add-ons for ADT including Project Navigator based 
Standards checker – also is programmer for: 
FaciliCad.com – inexpensive facilites management package 
http://www.stardsign.com/ - Rob Starz – there is an R3 FAQ posted on his site 
http://www.stardsign.com/adt_faq.htm 
www.dtitech.com  - training and add on packages 
http://www.archidigm.com/ - training and add on packages 
http://pointa.autodesk.com/local/enu/portal/community/browse.jsp?prod=adt 
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Not Quite Tips and Tricks 
 
Ok, it’s not quite a tips and tricks section, this is where I put ideas before they get incorporated into the 
rest of the document. This may include bits from the help file or knowledge base. 

Use customized profile with the startup switch /p 
From the autodesk knowledge base Published date: 2003-06-26 ---ID: TS80768  
Applies to:  
AutoCAD® 2004 
AutoCAD® 2002 
AutoCAD® Mechanical 2004 
AutoCAD® Mechanical 6 
Autodesk® Architectural Desktop 2004 
Autodesk® Architectural Desktop Release 3.3 
Autodesk® Architectural Desktop Release 3 
Autodesk Map™ 2004 
Autodesk Map™ 6 
Autodesk® Mechanical Desktop® 2004 
Autodesk® Mechanical Desktop® 6 
 
Issue 
You want to start your AutoCAD® based product with a customized ARG profile from the program shortcut. 
Solution 
To have the customized profile available in a new Windows account: 
Start AutoCAD for the first time after installation with the standard profile, for example, <<Unnamed profile>>.  
Make modifications to the AutoCAD options in the current profile; properties are stored in registry/profile. Note 
that every variable that is marked with an AutoCAD icon will be saved in the drawing file and not in the profile.  
Export the profile into an ARG file, for example, to Myprofile.arg. Note that AutoCAD always exports to the 
current profile. To control which is the current profile, use the command CPROFILE.  
Review the ARG file that AutoCAD writes out. All the key entries have the standard <<Unnamed profile>> 
profile, for example: 
 
[HKEY_CURRENT_USER\Software\Autodesk\AutoCAD\R16.0\ACAD-203:409\Profiles\<<Unnamed profile>>] 
Change these entries appropriately with the customized profile name and save the file.  
 
In this example, replace the <<Unnamed profile>> entries with MyProfile using an text editor. For example: 
 
[HKEY_CURRENT_USER\Software\Autodesk\AutoCAD\R16.0\ACAD-203:409\Profiles\MyProfile] 
 
Now you can create a program shortcut under all users with your customized and corrected AutoCAD profile. 
In the Target box of the Shortcut Properties, enter " c:\program files\Autodesk\Autocad 2004\acad.exe" /p 
"c:\program files\Autodesk\Autocad 2004\Myprofile.arg".  
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Creating an AutoCAD 2004 shortcut from an Autodesk Architectural Desktop 2004 installation 
Be careful of this with 2005/06 – the install process will do this for you 
From the autodesk knowledge base Published date: 2003-08-05---ID: TS79806 ---Applies to:  
Autodesk® Architectural Desktop 2004 
 

Issue 
You installed Autodesk® Architectural Desktop 2004 and want to create a shortcut that will launch an 
AutoCAD® 2004 session that does not include any of the Autodesk Architectural Desktop functionality. 
Solution 
 
You can use the following process to create a shortcut that will launch an AutoCAD 2004 session without any 
Autodesk Architectural Desktop functionality:  
Start a session of Autodesk Architectural Desktop 2004.  
On the Format menu, click Options.  
In the Options dialog box, click the Profiles tab.  
Click Add to List.  
For the profile name enter ACAD 2004 and click Apply & Close.  You can add a description if desired.  
From the Available Profiles list, select ACAD 2004 and then click Set Current.  
In the Options dialog box, click the Open & Save tab.  
Under Demand Load ObjectARX Apps, select Disable Load on Demand and click Apply then click OK.  
On the command line enter MENULOAD and press ENTER.  
In the Menu Customization dialog box, select the Menu Groups tab.  
Select the first entry in the Menu Groups list and click Unload.  
Repeat step 11 until all entries have been removed from the Menu Groups list and then click Browse.  
In the Select Menu File dialog box, from the Files of Type list select Menu Template (*.mnu).  
Select acad.mnu and click Open.  
In the Menu Customization dialog box, click Load.  
A dialog box will display with a warning that loading a template menu file will overwrite the menu source files.  
Click Yes to continue loading the mnu file.  
In the Menu Customization dialog box, click Close.  
On the Format menu, click Options.  
In the Options dialog box, click the Profiles tab.  
From Available Profiles list, select ACAD 2004 and click Export.  
In the Export Profile dialog box, navigate to the directory where you want to save this file, then enter the 
desired file name and click Save. We recommend that you save the resultant ARG file in the Autodesk 
Architectural Desktop 2004 installation directory.  
In the Options dialog box, click OK and then exit the Autodesk Architectural Desktop 2004 session.  
On the Windows Desktop, make a copy of your Autodesk Architectural Desktop 2004 shortcut.  
Select the copy of your Autodesk Architectural Desktop 2004 shortcut, right-click, and on the shortcut menu 
click Properties .  
Edit the Target path by removing the \t and \ld switches and modify the \p switch to use the new ARG file 
created in step 11.  The following is an example of the resultant Target path: C:\Program Files\Autodesk 
Architectural Desktop 2004\acad.exe /p or C:\Program Files\Autodesk Architectural Desktop 2004\ACAD 
2004.arg"  
Click OK to exit the Shortcut Properties dialog box. 
Sessions of Autodesk Architectural Desktop 2004 that you launch from the resultant shortcut will only include 
the AutoCAD functionality. 
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Course Evaluation 
Please take a moment to complete this evaluation.  Your comments will help me to improve my classes. - 
thanks 
 
Instructor: David Driver         Course:_________________________ 
 
Location:_____________________________       Date:___________________________ 
 
  please circle your rating 
  ( poor                               excellent ) 
   
course The course was well organized. -1 2 3 4 5+ 
   
 The course content met my needs. -1 2 3 4 5+ 
   
 The course pace was reasonable. -1 2 3 4 5+ 
   
 I have acquired many valuable/new skills. -1 2 3 4 5+ 
   
materials The courseware was thorough. -1 2 3 4 5+ 
   
 The courseware was easy to understand. -1 2 3 4 5+ 
   
 The sample exercises were effective. -1 2 3 4 5+ 
   
instructor The instructor was knowledgeable. -1 2 3 4 5+ 
   
 The presentation was clear & effective. -1 2 3 4 5+ 
   
 The instructor encouraged class participation. -1 2 3 4 5+ 
 
What was your overall opinion of the course?  _________________________________ 
 
What was the most important item you gained from attending?____________________ 
 
______________________________________________________________________ 
 
Additional comments (How would YOU improve the class?): 
____________________________________________________________________________________
____________________________________________________________________________________
____________________________________________________________ 
 
(optional)  Name:______________________   Company:_________________________ 
 
email  _________________________________ 
 
please fill out in class and give it to me, or mail to: 
4D Architects Ltd.  1454 Ashland St #202, Ashland Oregon, 97520 
 
 
 
 


